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or completeness of the information contained herein.
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Notes, Cautions, etc.

Illustrations and components are representative only. Your
unit may differ slightly from those pictured in this document.

NOTE
A note appears like this. A note provides
additional information to supplement the
main text which helps you to use and
understand the product.

Important!
An important message appears like this. An important

message provides supplemental information which can
prevent potential problems.

CAUTION!

A caution appears like this. A caution provides
additional information which, if ignored, may result in
equipment malfunction or damage.
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Network Configuration Overview

Introduction

NOTE
Not all utilities, features or protocols are
supported by every product. See the front cover
of this manual for a listing of the items
supported by your product.

Your unit incorporates a fast 100BASE-TX/10BASE-T network
interface. This User’s Guide explains the functionality of the
built in network interface and details the network interface
specifications and several software utilities.*
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Specifications

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

Frame Types o IEEE 802.2
e IEEE 802.3
e Ethernet-1I, SNAP, AUTO

Network Interface e 100BASE-TX
e 10BASE-T

Network Protocols e TCP/IP V4, V6
e IEEE 802.1x
e Network layer: ARP, RARP, IP, ICMP
e Session layer: TCP, UDP

e Application layer:LPR, FTP, TELNET, HTTP,
IPP, BOOTP, DHCP, SNMP, DNS, SMTP,
POP3, SLP, Bonjour

e IPX/SPX (NetWare)

e Remote printer mode (up to eight file
servers and 32 queues)

e Print server mode over IPX/SPX (up to
eight print servers)

e Encrypted password supported in print
server mode

e EtherTalk
e NetBEUI
e NetBIOS, WINS

Functions e Banner supported

e Monitoring and configuration by Web
browser

e Printer status notification by E-Mail

Network User’s Guide
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Printing the Network Configuration
Report

To print the Network Configuration report from most units:

NOTE

If these steps do not work with your unit, check
your Setup Guide or the On-line User’s Guide

(on the CD supplied with the unit) for
instructions.

1. Press the ENTER button on your printer to display
INFORMATION MENU on the LCD.

2. Press ENTER to select the menu.

3. Press the DOWN ARROW until NETWORK MENU is
displayed on the LCD.

4. Press ENTER to print.

Keep these sheets handy: they contain information you need
to set up the printer on your network.

Network User’s Guide
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Configuration utilities

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

You can configure the network interface (NIC) by using one of
the following methods:

System
Utility Features Requirements
Admin Configure the NIC easily and | Windows XP/Vista
Manager simply without installing any | (TCP/IP protocol or
Quick Setup software packages into your | IPX/SPX protocol
(see system. You can set the should be installed).

page 12) following:

e Enable/disable TCP/IP,
NetWare, EtherTalk,
NetBEUI protocols.

e Set IP address, Subnet
Mask and Gateway for
TCP/IP manually or by
using DHCP.

e Set NetWare Mode and
create Queue/Print
Server/Printer objects.

e Zone name and Port
name for EtherTalk.

Admin Configure the NIC in detail.
Manager
Standard
Setup
(see
page 14)
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Utility

Features

System
Requirements

Web Browser
(see
page 42)

Configure the NIC and
printer by using a Web
browser such as Microsoft
Internet browser or
Netscape Navigator.

Microsoft Internet
Explorer or similar.
Operating system

that supports Web
browser.

TELNET (see
page 43)

Configure the NIC using
TELNET.

Third-party vendor
developed TELNET
client package.

A TELNET Application
is standard in
Windows/UNIX/
Linux.

SNMP (see
page 46)

The printer and network
interface can be controlled
using third-party vendor
developed SNMP application.

Third-party vendor
developed SNMP
application.
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Network Configuration using
AdminManager

AdminManager Quick Setup

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

The AdminManager Quick Setup utility allows you to configure
the network interface easily and simply without installing any
software packages.

You can configure the following:

Enable/disable TCP/IP, NetWare, EtherTalk, and NetBEUI
protocols.

Set IP address, Subnet Mask and Gateway for TCP/IP
manually or by using DHCP.

Set NetWare mode and create Queue/Print Server/Printer
objects.

Set the Zone name and Port name for EtherTalk.

Configuration requires a PC with Windows XP or Vista
operating system, running TCP/IP or IPX/SPX (NetWare).

This utility can only be used on a PC that can be connected to
the network with TCP/IP or IPX/SPX.

This utility must be used on a PC that is located on the same
segment as the printer.
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1. Insert the CD into the CD-ROM drive. The Setup Utility
starts automatically. If it does not start, double-click
\setup.exe (in the root directory) on the CD.

OKI

PRINTING SOLUTIONS

) tnstall Admin Manager{Quick Sctup Utility)

= Vall mis masra.

Tnstall Direct Hetwork Printing Utlity (LPR)

= Vall mis masra.

Tnstall Metwork Extension

*> Tull e more.

== Tull e pre:

Install PDF Print Direct

*> Tull e more.

0
0
€ Install Color Swatch utiity
0
0

Change the Printer Display language
5 Tell e e
) Install Color Acorss Control
=) Register your Printer

[hicking this wil athempt to lwunch & Wab
Urewmar and ennact ts tha Intarsat)

N

. Select the appropriate language and follow the on-screen
instructions.

. Accept the Software License Agreement.
. Select the Optional Utilities tab.
. Then select Install Admin Manager.

. Select Oki Device Quick Setup and follow the
on-screen instructions.

U hW

o

OKI

perie

| Setup Utility

g e s it e

7. When the settings are correct, click Execute. The new
settings are transmitted to the network interface but it
still operates with pre-transmission settings.

8. Click Finish to validate the new settings.
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9. Switch the printer off for 15 seconds and on again.

AdminManager Standard Setup

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

AdminManager is a powerful Microsoft Windows-based utility
to configure all network interface functions easily and
intuitively via a graphical user interface.

Configuration requires a PC with Windows XP /2000 Advanced
Server or Vista, running TCP/IP or IPX/SPX (NetWare).

This utility can only be used on a PC that can be connected to
the network with TCP/IP or IPX/SPX and must be used on a PC
that is located on the same segment as the printer.

Installation

1. Insert the Network Software CD into the CD-ROM drive.
The Setup Utility starts automatically. If it does not start,
double-click \setup.exe (in the root directory) on the
CD.

OKI

PRINTING SOLUTIONS

D estall Adin Wanager] Quick Setup chiSey}
5 el —

D) Inatam Diret Mtk Printing tEty (L)
Rl —

D Iestall Metwork Cxtansien
= o e e

O hstall Colur Susatch Uiy
Nl e

3 dtall POF Print fdomct
= el

-l e

O testall Colur Access Comtrol
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N

. Select the appropriate language and follow the on-screen
instructions.

. Accept the Software License Agreement.
. Select the Optional Utilities tab.
. Then select Install Admin Manager.

. Select Oki Device Standard Setup and follow the
on-screen instructions.

o hW

Oki Data Corporation
e

7. If you want to install AdminManager on to your local
drive, select Install and Execute. Otherwise, select
Execute from CD-ROM. Follow the on-screen
instructions.

PWeIcnme g = *

I g ‘Welcome to Standard Setup

& Execute from CO-ROM

" Install and Execute

O/ Network Solutions
7 fora Giobai Society

Mext = Cancel I

8. To run AdminManager, check Yes for Do you wish to
execute AdminManager?, otherwise check No.

9. Click Finish.
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Interface

Select Start > Programs > Oki Setup Utility > Admin
Manager.

e _-.-I- 1 I.—
ARHEBALHE TN
Printer Name | ModdSetup 5 HTTR] | Ethermet Address IP Address
NN CkiLAN 83008 00:80:87:54:75:15 169.254.74.240
< I >
Menu Item Function
File Search Search printers in your network and list all
printers.
Status | Printer Current printer status is
. (=3
Status displayed: &
System Displays current NIC

Status configuration.
Configuration data can
be saved as log file.

List of Displays current NIC
Configurat | configuration.

ion Items | Configuration data can
be saved as log file.
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Menu Item Function

Setup | OKki Configure the network interface (NIC).
Device
Setup
Setup by Launch the default browser in your
HTTP environment to access the selected printer’s

web page.
Setup by Launch TELNET application in your
TELNET environment to access the selected printer’s
TELNET port.

Setup | Create Create a NetWare queue.
NetWare Note: Only visible when using Netware
Queue
Delete Delete NetWare object.
NetWare Note: Only visible when using Netware
Object
Reset Reset the selected network interface.
Test Print Print self-diagnostic test pages.
IP Set static IP address of network interface
Address manually.
Setup

Network User’s Guide
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Device setup

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

Device Setup allows you to configure the network interface.
Type the root password (default value is the last 6 characters
of the MAC address) to configure. Remember that the root
password is case sensitive. If the MAC address contains any
alpha characters, type them as upper case. Device Setup
contains details for the following selectable tabs:

o General (see page 19)
TCP/IP (see page 20)
NetWare (see page 21)
Ethertalk (see page 24)
NetBEUI (see page 25)
SNMP (see page 26)

Email ([Send] (see page 28)
Email [Receive (SMTP POP3)] (see page 30)
SNTP (see page 32)
Maintenance (see page 33)
SSL/TLS (see page 35)

e TEEE 802.1x (see page 38)

The following section explains each tab’s functionality.
Depending on your printer, some items in the following
explanation may not be displayed.y
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General Tab

OKI Device Setup

adrmin Password

General | TCRAP | Metware | EtherTalk | NetBEU! | SNMP | E-dailgsend) | E-tailg « | >

Change J

|

| o |

This allows you to set or change the root password used for
Admin Manager, TELNET and FTP.

Password Setup

Old password ’7

Mew passward ,—

Caonfirm new password ’—

0K Cancel J

Item Explanation
Change root You can set/change the root password for
password AdminManager, TELNET and FTP.

Network User’s Guide
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TCP/IP Tab

This allows you to configure TCP/IP related items

Item Explanation
Use Set TCP/IP protocol as enabled/disabled.
lcpt/ Ip | [ Use DHCP/BOOTP | Check this item if IP address,
rotoco subnet mask, default gateway
and IP addresses for DNS
primary server and secondary
servers are retrieved from the
DHCP or BOOTP server.
Otherwise, uncheck.
Use IPv6 Enables IPv6.
IP Address Set the IP address of the
selected network interface.
Subnet Mask Set the subnet mask of the
selected network interface.
Default Gateway Set the default gateway of the
selected network interface.
Auto Configure items related to Network e
Discovery | PnP
Use to select Network PnP and
Bonjour, and to set device name. .
DNS Set IP addresses for DNS A a)
Server.. primary and secondary

servers.
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Item Explanation

WINS Set IP addresses for WINS o

Server primary and secondary - AN KN KN N
servers and to enter scope i AEENENE
1D.

WINS Configure items related to the WINS Server.

Server... In this dialogue box, the following items can be
configured:
Primary Server Set WINS Primary server.
Secondary Server Set WINS Secondary server.
Scope ID Set a Scope ID.

NetWare Tab

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

This is where you can configure NetWare related items.

Item Explanation

Use Set NetWare protocol as enabled/disabled.
NetWare
Protocol

Use IPX Set protocol to use.
Protocol /
Use TCP/IP
Protocol

Print Set Print Server name.
Server
Name

Frame Type | Set primary NetWare frame type.
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Item

Explanation

Operation Set NetWare mode.
Mode
Check box Check if you want to use the Bindery mode and
beside Bindery Setup button becomes available. If it is
Bindery unchecked, the button is greyed out.
Setup
Bindery Configure items dery e ety 2k
Setup related to Bindery e
mode. ’
In this dialogue box, "
the following items —
can be configured: B
oK Cantel
Password. Set password for Print
Server.
Job Polling Time. Set print job polling
interval in seconds.
NDS Setup | Set NDS tree and T 0]
context where Print =
Server was created. o o
!
[ ok Can
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Item Explanation
RPRINTER Available if you o]
Setup select RPRINTER T EETER
mode in
Operation Mode. L
By Selecting the Detan for FPRINTIR =]
RPRINTER button, e s b et
this is displayed: ' :
Here you can specify
print servers to which
the printer can be e [ "
connected. Cor ] _ cme
Time Out Set duration from the
last data’s arrival to
freeing of the port in
seconds.
Printer Set the NetWare printer object name.
Name

Network User’s Guide
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EtherTalk Tab

K‘OKI Device Setup @
General | ToPAP | Netare EtherTalk | etsEul | stmp | E-maigendy | E-mang 4] >

v Use EtherTalk Protocol

PFrinter Name Icgggg

Zone Mame

Initialize Apply Cancel

NOTE
Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

This allows you to configure EtherTalk related items

Item Explanation

Use EtherTalk Set EtherTalk protocol to enabled/disabled.
Protocol

Printer Name Set EtherTalk Printer object name.

Zone Name Set the zone name to which the printer belongs.
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NetBEUI Tab

VOKI Device Setup E

General | TGRAP | Netware | EtherTalk NetBEU! | snmp | E-vailgsend) | E-waig + | >

¥ Use NetBEUI Protocol

Short Printer Mame ICBBDD-CBDEA4

Warkgroup IFrmlSeNer

Comment |EthemeIBUard OkiLAN 84508

Initialize Al Cancel

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover
of this manual for a listing of the items
supported by your product.

This allows you to configure NetBEUI related items

Item Explanation

Use NetBEUI Set NetBEUI protocol to enabled/disabled.
Protocol

Short Printer Set a name for the printer.

Name

Workgroup Set a work group name to which the printer
belongs.

Comment Set the comments for the printer (optional).
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SNMP Tab

OKI Device Setup

General | TCPIP | NetWare | EtherTalk | NetBEUI SNMP | E-MailiSend) | E-Mailg 4] ¥

v Use SNMP Service

SNMPY1 Setings ] SNMPY3 Setings 1

|SNMPYE + SHMPYT |

~MIB-Il Parameters -
SysContact |
SysName JOKI-CEBDD-CBDEA4

SysLocation J

Printet Trap Setup. ]

Cancel ]

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

This allows you to configure SNMP related items.

Item Explanation
Use SNMP ENABLE or DISABLE the SNMP protocol.
Service
SNMPV1+V3 Select from the drop-down box which (or both)
of these to use.
SNMPV1 SNMP Read & | Enables these passwords to be
Settings Write changed.
Community.
SNMPV3 Enables Authorization and Privacy (Encryption)
Settings setup to be done.
SysContact Set SysContact (printer manager) name.
SysName Set SysName (printer model name).
SysLocation Set SysLocation (the location where the printer
is installed).
Default TTL Set TTL (Time To Live) value.
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Item

Printer Trap
Setup...

Explanation

By selecting the SR 5

button, the following

dialogue box is on T o

displayed: o KA '

In the dialogue box, wu [ o

the following items i AEENENEN]

can be configured:
C= ] o

Printer Trap This community name is

Community assigned to outgoing printer

Name status traps such as off-line,

paper out, etc.
TCP#1-5 Set the IP addresses to which a

Trap packet will be sent. You
can set up to five IP addresses,
with the following details:
Printer Reboot

Receive Illegal

On-Line

Off-Line

Paper Out

Paper Jam

Cover Open

Printer Error (any error)

IPX Set node address and network
address to which a Trap packet
will be sent.

By selecting the button, the
following dialogue box is
displayed:

In the dialogue box, the
following items can be
configured:

Printer Reboot

Receive Illegal

On-Line

Off-Line

Paper Out

Paper Jam

Cover Open

Printer Error (any error)
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E-Mail (Send) Tab

OKI Device Setup

%]

General | TCPIP |

1

I~ Use SMTP Transmit

SMTP Server Name I

Printer E-mail Address I

- Destination Addn

Metwiare | EtherTalk | NetBEUI | ShmP E-MailtSend) IE-MaH(F 4

Attach Infa I Comment. l

Authentication | Others: I

....

| ARl Cancel |

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

This allows you to configure SMTP related items.

Item Explanation

Use SMTP Check to enable SMTP

Transmit

SMTP Server Enter name of the SMTP server

Name

Printer E-Mail Enter the printers e-mail address

Address

Destination Set the following parameters:

Address 1 - 5 Destination Set E-Mail address to which
Address email should be sent.
Notify Mode Select PERIOD or EVENT

When PERIOD is selected:

Network User’s Guide
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Item

Explanation

Check time

Used to set the interval at
which the selected events
are checked. An e-mail will
be sent at the specified
interval for each event
selected.

Period mode

Set ON/OFF for the events
listed.

When EVENT is selected:

Event Mode

Select:

ENABLE (ON), DISABLE
(OFF) or IMMEDIATE
(NOWAIT) for the listed
events. If ENABLE (ON) is
selected, the check interval
is settable in hours and
intervals of 15 mins.

Attach Info...

Select whichever information is to be included

in the e-mail.

Comment...

Set up to four lines of text to be included with
the e-mail as comments.

Authentication...

Used to set the following security information:

Use SMTP Check to Enable SMTP
Authentication Authentication.
User ID Set the User ID for

Authentication

User Password

Set the User Password for
Authentication.

Others...

Set the following:

SMTP Port
Number

Set the SMTP port number
(default is 25)

Reply to address

Set the E-mail address used
for the [Reply to] field in the
mail header.

Network User’s Guide
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E-mail (Receive) Tab

-
OKI Device Setup @
TOPIR | Neteare | EtherTalk | NetBEUI | SNMP | E-MailiSend) E-Mail{Receive) i 4r

~POF Receive
[~ Use POP Receive
POP3 Senver
POP3 Sarver User ID l—
POP2 Server Pagsword l—
FOF Detail
~SMTF Receive
I~ Use SMTP Receive
Damain Filter...

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

Some printers support an email reception function (SMTP/
POP3) allowing the printer to print PDF and text files attached
to emails. If this tab is not displayed, your printer does not
support the function.

Item Comments

Use POP Receive Enable/disable receiving E-Mail via POP3.

POP3 Server Set the IP address or host name of the POP3
server.

POP3 Server UserID | Set User ID for POP3 server.

POP3 Server Set a password for the POP3 server.

Password
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Item

Comments

POP Detail...

Set the following:

Use APOP | Select if you want to use APOP.
POP3 Port | Set the port number for APOP
Number (default is 110).

Mail Polling| Set interval to retrieve E-
Time Mail(s) from the POP3 server.

Selectable values, OFF, 1min,
5min (default), 10min, 30 min,
60 min.

Use SMTP Receive

Enable/disable SMTP receive.

Domain Filter...

Set the following:

Use Enable/disable domain filtering.

Domain

Filter

Filter Policy| Select ACCEPT (the default) or
DENY.

Domain Define up to five domain filters.

Filter
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SNTP Tab

-
OKI Device Setup

[~ Use SNTP

Adjust Interval

Local Time Zone

I~ Daylight Saving

NEtBEUI | SNMP | E-MailSend) | E-MailReceive) SNTP | Maintenance | SsUTLS 4

NTP Server 1 Address ]

NTP Server 2 Address J

Cancel

Not all utilities,
supported by ev

NOTE
features or protocols are
ery product. See the front cover

of this manual for a listing of the items
supported by your product.

In this Tab, you can

configure SNTP related items

Item

Comments

Use SNTP

Enable/disable SNTP (Simple Network Time
Protocol).

NTP Server 1

Set the IP address or host name for NTP

Address Server 1.
NTP Server 2 Set the IP address or host name for NTP
Address Server 2.

Adjust Interval

Set the interval for sending time update
requests to the server. Select 1 hour (the
default), 12 hours or 24 hours.

Local Time Zone

Set the local time zone from -12:00 to
+13:00. Minute interval is selectable from 00
(the default), 15, 30 or 45.

Daylight Saving

When this is selected, one hour is added to
the local time.
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Maintenance Tab

OKI Device Setup

0]

LAN Scale

NelBEUI | SNMP | E-MailiSend) | E-tailRecene) | ST Maintenance | ssimis 4] »

HORMAL |

P Filter Setup |

Service.. |

Cancel

Item

Comments

LAN Scale

Select NORMAL (the default) or SMALL.

Note: For small scale networks (with no
routing), choose the SMALL setting. For
more complex networks choose NORMAL.

IP Filter Setup...

The following items can be configured:

Use IP Fllter

Enable/disable IP Filtering.
Default is disabled.

Admin IP Enter the printer’s IP Address.

Address

IP Address Set up to 10 IP Filter address

Range ranges: [IP FIlter Range 1]
through [IIP Filter Range 10].

Printing Enable/disable printing of the

specified IP address range.
Default is disabled.

Configuration

Enable/disable changing IP
address ranges. Default is
disabled.
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Item

Comments

Service...

The following features can be selected by
clicking their check box.

TCP/IP Protocol

NetBEUI Protocol

NetWare Protocol

EtherTalk Protocol

FTP Service

Use Telnet Service

Use Web Service

Use SNMP Service

Use POP3 Protocol

Use SNTP

Use IPP

Use SNMTP

Use encrypted communication for
configuration data
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SSL/TLS Tab

OKI Device Setup E[ﬁ

SNMP | E-Mail(Send) | E-Mail(Receive) | SNTP | Maintenance  SSLTLS |\EEEBD: e

Encryption Strongth Standard _I
- Create Certificat
= Selt-signed Cerificate Creale Certificate..

 ChA-signed Certificate

Initialize Apply Cancel

NOTE
Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

Item Comments

Encryption Strength| Set the strength of encryption:

Strong = highest security, slowest speed
Standard = medium security, medium speed
Weak = least security, fastest speed
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Item

Comments

Self-signed
Certificate

For IPP encryption within an organization’s
internal network (intranet).

Create Certificate...

When Self-signed Certificate is selected, the
following items are configured:

Common
Name

The printer’s IP Address
appears here.

Organization

Enter the name of your
organization.

Organization
Unit

Optional. Allows you to enter a
subdivision or department
name.

Locality Enter the name of the city
where the organization is
located.

State/ Enter the state or province

Province where the organization is
located.

Country/ Enter the country or region

Region where the organization is
located.

Key Select RSA (the default) or

Exchange Diffie-Hellman(DSS).

Method

Key size Select 512, 1024 (the default),
or 2048 bits.

Term of Enter a starting and ending

Validity date (month/date/year) for

which the certificate is valid.
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Item Comments

CA-signed Used for web encryption to provide security
Certificate... when printing over the internet. Requires an
outside certification service which must be
purchased separately.

Create Certificate... | When CA-signed Certificate is selected, the
following items are configured:

Common The printer’s IP Address

Name appears here.

Organization | Enter the name of your
organization.

Organization | Optional. Allows you to enter a

Unit subdivision or department
name.

Locality Enter the name of the city
where the organization is
located.

State/ Enter the state or province

Province where the organization is
located.

Country/ Enter the country or region

Region where the organization is
located.

Key Select RSA (the default) or

Exchange Diffie-Hellman(DSS).

Method

Key size Select 1024 (the default) or
2048 bits.

Network User’s Guide
37




IEEE802.1X Tab

-
OKI Device Setup @
E-MailiSend) | E-mailiRecene) | SNTP | waintenance | ssLmLs IEEE8021% | 4] »

I~ UselEEEB02.1X

EAP Type |eapTLS =

EAP User I

I~ Use SSLITLS Cettificate

¥ Authenticate Server

Certificate I

Cancel I

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

Item Comments
Use IEEE802.1X Enable/disable.
EAP Type The following Extensible Authentication
Protocols can be configured:
EAP-TLS Selects Extensible
Authentication Protocol - TLS.
PEAP Selects Protected Extensible
Authentication Protocol -
(includes Password).
EAP User Enter EAP User name.
Use SSL/TLS Enable SSL/TLS certification.
Certificate
Authenticate Enable Server Authentication.
server
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Item Comments

Certificate Client File: (User can specify).
certificate Password: (User can specify).
Options to Import, Delete,
View.

CA certificate| File: (User can specify).
Password: (User can specify).

Options to Import, Delete,
View.

IP Address Setup

If you only use TCP/IP and the printer has not yet been
configured, occasionally it may not be displayed on
AdminManager. You can configure the IP address of the printer
by this function.

1. Select IP Address Setup from the Setup menu.
2. Set Ethernet Address and IP Address then select OK.

Ethemet Address ’T’E_D’T'T’T’?

IP Addrass | 163 ‘ 254 | 56 | 52

0K | Cancel

3. The Ethernet Address (MAC address) appears in the
Network Configuration report (see page 9).

Option Menu
In the [Option] menu, the following items can be selected:

Item Explanation

Use TCP/IP If this item is selected, AdminManager uses TCP/IP

Protocol protocol to search/configure network interfaces.

Use IPX/SPX | If this item is selected, AdminManager uses IPX/

Protocol SPX protocol to search/configure network
interfaces.
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Item

Explanation

Environment
Setup

TCP/IP Tab e o7
Set broadcast addresses that
are used to search printers ARSI

using the TCP/IP protocol. If J e
Use TCP/IP protocol is
unchecked, the search will not
be carried out using TCP/IP.

NetWare Tab

Set network addresses that are
used to search printers via
NetWare protocol. If there any
many NetWare file servers on
your network, specify the
network address to which the =
network interface belongs. If

Use NetWare protocol is unchecked, the search
will not be carried out using NetWare, but if Auto
Search is selected, AdminManager will search all
networks that AdminManager can detect.

SNMP Tab

Obtain the printer name via o
SNMP - Select

Enter Community name.
Add and Delete

TimeOut Tab == 77|
Search Every: Set response o
waiting time from a network
interface in seconds.

Time Out: Set time out
between AdminManager and
the network interface in ==
seconds.

Retry: Set how many times the retry will be carried
out between AdminManager and the network
interface.
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Help menu

In the Help menu, About is available as well as revision
information for AdminManager.
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Network Configuration using a Web
Browser

If the printer is connected to the network using TCP/IP, its
settings and the printer menu settings can be configured using
a Web browser. Refer to the relevant manuals for details of
how to launch and use the browser.

Using Microsoft Internet Explorer

1. Select Internet Options in the Tools menu.

2. Click on the General tab and click Settings in
Temporary Internet files.

3. Select Every visit to the page in Check for newer
versions of stored pages.

Default user name and password

To apply configuration changes using Microsoft Internet
Explorer (or another Web browser), you will be prompted for a
username and password. The username is root and the default
password is the last six characters of the Ethernet (MAC)
address (any alpha characters must be in upper case).

The root password can be changed to allow you to configure
the printer by using a Web browser/TELNET/AdminManager.
To change the root password, select “Password Configuration”
in the Maintenance tab and follow the on-screen instructions.

Adjusting printer settings

The network addresses used in this manual are shown as
examples only. Network addresses used in your installation
must be generated from your own network.

1. Configure the IP Address, Subnet Mask and Gateway for
the network interface. Launch the Web browser, enter
the IP Address of the network interface in Address
(Location/Position) and press the Enter key. The
Printer Status screen is displayed.

2. Select a tab and items to be changed in the left frame.
You need to log in as “root” to be able to configure all
items. Non-root users cannot configure all items.
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Network Configuration using
TELNET

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover
of this manual for a listing of the items
supported by your product.

CAUTION!

Please ensure a valid IP address for your
network environment is used. Use of an
incorrect IP address can cause serious problems
on your network.

Example TELNET configuration

TELNET requires the print server to have a valid IP address
configured. If the network interface already has an IP address
configured, skip steps 1 to 3 below.

NOTE
The method of configuring commands may

differ between workstations. Refer to the
workstation’s manual.

1. Use the PING command to confirm the connection with
the network interface.

Example
For IP address 172.168.20.127:
ping 172.168.20.127

If there is no reply, there is a problem with the configuration
of the IP address (the IP address has been already set

manually or by the DHCP/RARP server), or with the network.
Reset the network interface settings to the default (press the
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reset button next to the Ethernet port on the unit) and try to
set a temporary IP address. If you still have the problem after
resetting the network interface, consult the network manager.

2.

Login to the network interface using TELNET.
Example

For IP address 172.168.20.127

TELNET 172.168.20.127

You should see a sequence similar to the following
example:

Trying 172.168.20.127

Connected to 172.168.20.127

Escape character is ‘*]’.
EthernetBoard OkiLAN PRINTER".
login: root

‘root’ user needs password to login.
password:

User ‘root’ logged in.

No. MENU (level.l)

1l:Status / Information
2:Printer Config
3:Network Config
4:Security Config
5:Maintenance

99:Exit setup
Please select (1-99)7?

Enter the number of the item to be changed.
The details window for that item displays.

When the configuration is complete, select Exit Setup to
save your change. To exit without saving your
modification, select Quit.

Network User’s Guide
44



5. Turn the printer off and on again.

NOTE
The network interface continues to use

pre-transmission settings until the printer is
turned off and back on again.
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Network Configuration using SNMP

NOTE
Not all utilities, features or protocols are

supported by every product. See the front cover
of this manual for a listing of the items
supported by your product.

The printer and network interface can be managed via a
standard SNMP management station. The network interface
supports SNMPv1, MIB-II, Oki Data Private MIB and SNMP V3.
In order for the printer to be managed correctly from an SNMP
management station, the Oki Data Private MIB needs to be
added to that management station. Please refer to the SNMP
manager documentation for information on how to do this.

NOTE

The Oki Data Private MIB file can be found in the
MIB folder on the Network Software CD-RSGM or

the Oki Printing Solutions Website. Please refer
to the readme file for further information.

The printer’s trap address can be set in five places using TCP/
IP and in one place with IPX.

Printer trap settings can be made with TELNET and a Web
browser.
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Network Configuration using the
PrintSuperVision Utility

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

PrintSuperVision is a web-based application for managing
printing devices connected to a network. It consists of two
parts:

e A web application based on Microsoft web server (Internet
Information Server, IIS or Personal WEB Server, PWS), that
provides the user interface.

e A monitoring program (PrintSuperVisor) that runs all the
time, collecting data and saving it in a database for
statistical reports and sending E-Mail alerts based on the
saved configuration.

PrintSuperVision requires the .NET environment to be installed
on the PC on which it runs. The supplied installer will install this
if necessary.

PrintSuperVision’s main functions are:

e Maintaining the list of printing devices and organizing them
in logical groups.

e Initially discovering and configuring printers connected to
the network.

® |ocating printers visually on maps.

e Monitoring devices over time and saving data for statistical
reports.

e Sending email alerts when events occur that affect the
functionality of printers.

e Statistical reports about usage of printers.

e Tracking maintenance data related to printers.
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e Identifying part numbers of consumable items for use with

your printer.

e Integrating with Oki Data’s on-line web support (for US and

Canada).

e PrintSuperVision can even manage printers on another
network provided a copy of PrintSuperVision is also running
on that network.

System Requirements

The main PrintSuperVision application can be installed in any
of the following Windows systems.

Operating Service 11st MDAC and .Net
System Pack Framework
Windows 2003 IIS 6.0 .Net Framework 1.1
Server included in installed as part of
1. Web Edition the OS. the OS.
2. Standard 1. 1ISs 6.0
Edition installed by
3. Enterprise default
Edition 2, 3,4.1IS
4. Datacenter 6.0 optionally
Edition installed (on
the CD)
Windows XP 1.0 IIS installed MDAC and .Net
Professional as an option. Framework are
Available in available for
the Windows download from
XP CD. Microsoft.
Install IIS MDAC 2.7 and .Net
before Framework Version
installing .Net | 1.0.3705 are
framework. included as part of
PSV install.
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Operating Service 11st MDAC and .Net
System Pack Framework
Windows 2000 2.0 Internet MDAC and .Net
Professional Service Framework are
X Manager available for

Windows 2000 included in download from
Server / the OS. Microsoft.
Advanced Server Available in MDAC 2.7 and .Net
/ Datacenter the Windows | Framework Version
Server 2000 CD. 1.0.3705 are

Install IIS included as part of

before PSV install.

installing .Net

framework.
Windows XP 1.0 Works only
Home with PSV

Embedded

Web Server,

available in

the PSV

Install

Package.

Windows Vista

Not supported

1. An Embedded Web Server option is provided which does not require IIS.

Supported Browsers

The PrintSuperVision application can be accessed from most
Windows, Macintosh, Unix, and Linux desktops.

PrintSuperVision works best when used with Internet Explorer.

When using the Netscape browser, do not select the option
Images off as the hyperlinks may not work properly. Some
versions of Netscape browser do not display the frames
properly, and the Back button may not work correctly.
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Supported Printers

PrintSuperVision provides general management information
for printers connected to the network. For Oki printers,
additional details, reports and added features are available.

While the printer properties are displayed in PrintSuperVision,
only a few of the printer settings can be set. For setting any
other printer settings, a hyperlink to the printer’'s web page is
provided in PrintSuperVision.

Installing Print SuperVision

This section describes installing Print SuperVision from the
supplied CD-ROM.

NOTE
Some Operating Systems require administrator

privileges in order to make changes.

1. Insert the CD-RGM into the CD-ROM drive. The Setup
Utility starts automatically. If it does not start,
double-click \setup.exe on the CD-ROM.

2. Select Internet Downloads.
3. Select PrintSuperVision.

4. When installation ends, the Setup complete screen is
displayed. Click Finish.

5. Now you should select: Start > Programs >
PrintSuperVision > PrintSuperVision or double-click
the PrintSuperVision icon on the desktop for the
PrintSuperVision server.

6. For PrintSuperVision client, access http://server IP
address or host name/PrintSuperVision from the
Web browser. If you change the port humber you should
add port number. Example: http://192.168.20.127/
PrintSuperVision:8080.

7. PrintSuperVision has an on-line help facility.
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Uninstalling PrintSuperVision
To uninstall PrintSuperVision, either

® select: Start > Programs > PrintSuperVision >
Uninstall PrintSuperVision,

e or from Control Panel, select Add/Remove Programs,
select PrintSuperVision from the index window and click
Add/Remove. When the uninstallation is completed, close
Add/Remove Programs.

In some cases, an empty Okidata/PrintSuperVision/
directory may be left behind. Delete the directory manually.
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Network Configuration using the
Oki LPR Utility

NOTE
Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

The Oki LPR Utility is a utility that allows printing data to
printers connected to the network via TCP/IP.

The utility is for those Oki printers which support TCP/IP. It
redirects printing data to the Ipr port of the specified IP
address.

It is an alternative method of connecting printers instead of
using the Microsoft TCP/IP port.

System Requirements

Operating Systems with TCP/IP support and Oki printers that
support TCP/IP.

Installing the Oki LPR utility

NOTE
Some Operating Systems require administrator

privileges in order to make changes.

1. Set up the printer driver by designating the output
destination to Local Printer (LPT1:). For information on
setting up your printer driver, see the printer user guide.

2. Insert the CD into the CD-ROM drive. The Setup Utility
starts automatically. If it does not start, double-click
setup.exe on the CD-ROM.

. Select Optional Utilities.
. Select Install Direct Network Printing Utility (LPR).
5. Follow the on-screen instructions.

H» W
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10.

11.

12,
13.

14.
15.
16.

. Click Next when the Welcome screen is displayed.
. Verify Destination Folder and Spool Folder and click

Next.

. If you want automatic startup as Windows boots up,

check Register in Startup. If you want to start up in the
Icon state, check Launch as minimized. Click Next.

. Verify the program folder name and click Next.

The installation starts.

When the installation ends, the Setup complete screen
is displayed. Check Yes, I want to launch Oki LPR
Utility now and click Finish. Check Yes, I want to
view the ReadMe File if you want to read Readme.
The OkILPR utility will start.

You may be asked whether it is okay to change write
permissions for the spool directory. Click Yes to allow the
utility to be installed correctly.

Select Add Printer on the Remote Print menu.

Click Discover... to search for the IP address of a
suitable printer on your network.

Highlight the printer you will use and click OK.
If your printer is not discovered, click Cancel.

Enter an IP address at IP Address and click OK. A
printer is added to the main window.

Refer to the On-line Help for information on how to use the
utility.

Uninstalling the Oki LPR Utility

NOTE

If a file that has been added after installation
exists in the folder to install the OkiLPR utility or

the folder to spool, you cannot delete the folder.
Delete any unwanted files before running
Uninstall OkIiLPR Utility.

1.
2.

Stop the OKiLPR Utility.

Select Start > Programs > Okidata > OkiLPR Utility
> Uninstall OkiLPR Utility.
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3.

4.

You may find this under Start > All Programs in
Windows XP.

Click Yes when the Confirm File Deletion dialog is
displayed.
Deletion of the OkiLPR utility starts.

. When the deletion has finished, the Uninstall Complete

screen is displayed. Click OK.
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Network Printing using Microsoft
Windows

Overview

This chapter provides guidelines on how to print over the
network from various Microsoft Windows platforms. There are
numerous ways of printing from Windows and the exact set-up
will vary depending upon your environment. There are also
numerous versions of Windows, which can be configured as
either a client, server or both.

Although there are many variants of Windows, the principles
of network printing are the same. Microsoft provides on-line
help with all of their operating systems and this is a good
reference point for the exact details of each configuration
option within Windows.

NOTE
Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

Installing a Network Printer
There are two ways to set up a Network Printer in Windows:

e Install automatically, using the Oki Driver Installer

e Install it yourself using the Add Printer Wizard

Using the Oki Driver Installer

The Oki Driver Installer program searches for compatible
printers on the Network, then installs and configures the
printer drivers with the correct port settings automatically.

Using the Oki Driver Installer program, you can install to the
following networked printers:

e Directly connected (peer-to-peer) printers via TCP/IP
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The Microsoft standard TCP/IP is installed and configured
to use Port 9100 with the printer’s IP address.

e Printers not directly connected, but shared via a PC (Client
Server)

Why use the Oki Driver Installer?

o Automatically discovers printers on the Network (TCP/IP)

e Installs driver and correctly assigns the appropriate port
and IP address

e Allows easy configuration and sharing of the printer with
other Network users

e Automatically configures the printer driver with the
appropriate hardware device options such as hard disc
drive, duplex unit, etc. (via the Oki Network Extension
software)

Using the Add Printer Wizard

Method summary:

The following table shows the different ways to connect to the
printer (port types).

Windows | Windows | Windows
2000 XP Vista
Windows Rally NO NO YES
Windows standard TCP/IP YES YES YES
Oki LPR YES YES NO
IPP YES YES YES
NetBEUI YES YES NO

About the different methods
Windows Rally

Windows Rally is an automated “Plug-n-Play” type utility that
allows users to discover and configure network devices
effortlessly.
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Windows standard TCP/IP port

The standard TCP/IP port simplifies connecting to remote
printers using the TCP/IP protocol. A computer that acts as a
print server must run the TCP/IP protocol in order to print.

Can be configured to use either LPR or RAW (e.g. Port9100).
OKiLPR
Used to connect your printer over TCP/IP using an LPR port.

OkiLPR also includes useful tools enabling you to download PS
and PRN files directly to your printer and automatically redirect
jobs to other printers on the network.

IPP

The IPP (Internet Printing Protocol) defines a standard protocol
for printing as well as managing print jobs, media, resolution
etc.

NetBEUI

NetBEUI (NetBios Extended User Interface) is a protocol that
was designed for use in small workgroups or LANs. Within
Windows NetBEUI is used for file and printer sharing between
computers. It provides a simple method of printing, but it does
have limitations, and is not as robust as TCP/IP or IPX.
Typically it is employed in small business or home networks.

Network Printer IP Address
Configuration

Use the Standard Set-up Utility on the CD supplied with your
unit to configure the IP Address, Subnet Mask and Gateway.

NOTES

It will not be necessary for printers connected
to a network using DCHP to use this setup

method.

Some steps may not display depending on the
network protocols installed.

1. Connect the printer to the network and turn it on.
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2. Insert the CD into the CD-ROM drive. The Setup Utility
starts automatically. If it does not start, double-click
\setup.exe (in the root directory) on the CD.

3. Select the appropriate language and follow the on-screen
instructions.

Accept the Software License Agreement.
. Select the Optional Utilities tab.

o p

OKI

PRINTING SOLUTIONS

0 Install Admin Manager( Quick Setup ility)

D Install Direct Netwark Printing Utility (LPR)

== Tall ma mars.

) install Network Extension
= Tall ma more

0 tnstall Color Swatch Utllity

0 mstall POF Print Direct

O Change the Prister Display languags
*> Tall me more.
£ Install Color Access Control
= Register your Printer

(ueking this wil attamp b launch & Wah
Brovsar and cnnert bn the intaret]

6. Then select Install Admin Manager.

7. Select Oki Device Quick Setup and follow the
on-screen instructions.
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8. Select the appropriate network interface, using the
Ethernet address to identify it, and click Next.

NOTE
The Ethernet address of the printer can be found
on the Network Configuration printout (see

“Printing the Network Configuration Report” on
page 9).

If you are using TCP/IP protocol:

a. When using Ipr in UNIX and other TCP/IP environments,
please select Yes. To use in a TCP/IP environment, an IP
address should be assigned to the Ethernet interface.

b. If Yes has been selected and TCP/IP is the only working
protocol and the IP address has not already been assigned,
you can either obtain an IP address automatically or assign
an IP address.

c. When Obtain an IP address automatically is selected, the
device IP address will be automatically assigned by the
DHCP server. In an environment without a DHCP server,
please assign the IP address manually.

d. If you are manually assigning an IP address, you need to
enter:

®An IP address

eSubnet mask

eGateway address.
e. Click Next.

Using Bonjour protocol

Bonjour is the preferred protocol for printing data from
the Macintosh environment.

Using NetBEUI protocol

Using NetBEUI makes it easy to manage your OKki
product and print within the network environment of
Windows.
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9. When the settings are correct, click Execute. The new
settings are transmitted to the network interface but it
still operates with pre-transmission settings.

10. Click Finish to validate the new settings.
11. Switch the printer off for 15 seconds and on again.

Now that both Windows and the printer have been configured
to use TCP/IP, the next step is to configure Windows to print
to the network printer.

NetBEUI Protocol

Network Printer Settings

There are two configurable items under NetBEUI within the
printer. These can be configured using the standard set-up
utility described in “Device setup” on page 18.

Computer Name | Name assigned to the printer

Workgroup PrintServer!

Comment User definable description

1. Although the workgroup name can be changed, it is
recommended that it remains as PrintServer.

Although there are some differences in configuration options
between the various Windows platforms, the procedure for
printing using NetBEUI is the same.

Please ensure the NetBEUI protocol has been installed in
Windows. This can be confirmed by checking the network
settings. If NetBEUI has not been installed please refer to the
section below.

The relevant Windows installation CD may be required and you
should follow the on-screen dialog box prompts.

Windows XP

Although you can install the NetBEUI protocol into Windows
XP, it may not be supported. You should be able to use
NetBEUI on LAN connections although you will not be able to
use this on a Remote Access Service Connections.

1. In the Start menu, select Settings then Control Panel.
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Double-click on Network Connections.

3. Right-click the adapter to which you wish to add NetBEUI
and then click Properties.

4. On the General tab, select Install.

5. Select Protocol and then Add.

6. Select Have Disk and insert your Windows XP CD, open

the Valueadd\ msft\net\netbeui folder, select the
Netnbf.inf file and then click Open.
Now the printer has been configured and NetBEUI has been
installed, you can configure Windows to print over the
network.

N

Windows Vista
NetBEUI is not supported by Windows Vista.
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Printer driver configuration

In the following example, the printer has been configured as
follows:

Computer OL07DB85
Name:

Workgroup: PrintServer

Comment: Ethernet Board 8100e

Set up the printer driver as the default local printer.
In the Start menu, select Settings then Printers.
Select the relevant printer driver, then Properties.
Click on the Details tab in the printer driver.

Select Add Port.

Select Network and click Browse.

Double-click Entire Network, PrintServer and
OLO7DBS8S5.

Select Prnl1 and click OK.
9. Check that Network is selected and click OK.

NoOUhRWwN#=

o

10. Select Apply and OK to close Properties.
Printing can be carried out using your application software.

The Master Browser function manages machine information
from the same Workgroup, and replies to summary
requests from other workgroups.

The Master Browser function operates only if the
Workgroup name is PrintServer.

The Master Browser function can only manage this network
interface. If the PrintServer name is put into another
Workgroup, the network interface will not be able to find it
on the network.

A maximum of eight Networks can be managed by the
Master Browser function.

Printing cannot be carried out and an error message
appears when jobs from other users (including other
protocols) are being printed.
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Network Printing using Apple
Macintosh

NOTE
Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.

Overview

This section of the guide is for administrators and it should be
read in conjunction with the relevant MacOS manual.

To get the best results from your printer, install the Postscript
Printer Description (PPD) file supplied with your printer and
use this to customize the Apple PostScript driver that is built-in
to the OS X. Features provided by the PPD file include:

® Supported paper types
e Paper trays

® Printer resolution

® Printer color matching

NOTE
The PPD file must be installed using the Oki

Driver Installer to ensure that all essential files
are copied.

Setting up a Network Printer

1. If the printer does not already have an IP address, use
the Printer Setup Utility to assign an IP address (see
page 65).

To do this, you will need to know the printer's MAC
address. This can be found on the Network Configuration
report (see page 9).

Network User’s Guide
63



2. Install the printer driver software. This copies the printer
driver files to the correct location on your Mac OS X
system.

3. Make a connection to the printer by USB, TCP/IP,
Rendezvous or AppleTalk. See “"Connecting to Your
Printer” on page 76.

4. If required, enable hardware device options such as
duplex unit or printer hard disk. See “Configuring Printer
Hardware Options” on page 81.

MacOS Printer Setup Utility

The Printer Setup Utility is a powerful MacOS-based utility for
configuring all print server functions using a graphical user
interface.

Installing the printer setup utility

1. Insert the CD into the CD-ROM drive.

2. Open the Printer Setup Utility folder and double-click
Installer.

@ O ©® [ Printer Setup Utility (=]
o

3 items, Zerc KB available

o =
LI
Installer Info
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3. Select the destination directory, then click Next.

aman installer

If the folder destination for the installation is
changed, click on [Reference] and select the

OKI folder.
ege Y

.‘}4

Folder Destination for Installation

Tiger:Users: 10Kl Tools
Ok, Network Sobsom i
Rra el Dty ( Reference... )
e e e e —

< Back ext > ( Canceal )
€ Next> ) )

4. Ensure the Yes option is selected to activate the utility,
then click Finish.

ea|amn Installer

Setup Utility Installation is complete.

OKIX

PRINTING SOLLTIGNS

Next, you can activate the Setup Utility.

Do you want to activate the Setup Utility?

@ Yes
() No
Okl Network Sokions
T Tor a Global Society
<Back Cancel

The Printer Setup Utility Interface

The Printer Setup Utility auto-discovers Oki compatible
network interfaces.

Network User’s Guide
65



1. Select the correct printer NIC to configure and choose
Setup menu > Oki Device Setup.

8emn Setup Utility

A5 LB A

Model Name |Ethernemddress IP Address
00: :B4:58:FD
148

10.18.207.59

00:80:87:.CB:17:B7
OKiLAM 8450e 00:80:87:CB.0E:A4 10.18.207.108
OkiLAM 66009 00:80:87:0B:00:04 10.18.207.112
OKiLAM 6500e 00:80:87:D4:32:F4 10.18.207.87
OKiLAMN 8450e 00:80:87:74:57.26 10.18.207.55
OKiLAMN 8300e 00:80:87:D4:C2:39 10.18.207.96
OkiLAMN 84509 00:80:87:AB:54:F3 10.18.207.50
OKiLAM 8450e 00:80:87:CB:0E:AB 10.18.207.62

A0 Oki Devices are found in the network.

2. At the prompt, enter the Admin password.

Password

Input Password : |ww“1 |

] Guest user (read only)

( Cancel ) 6—“—5

NOTE

The default admin password is the last six digits
of the MAC Address, minus any punctuation

marks. e.g., for a MAC (Ethernet) Address of
00:80:87:A4:55:79, the password would be
A45579.

3. Select the TCP/IP tab and assign your printer’s IP
address.

Network User’s Guide
66



4. Click Apply.

OkiLAN 8450g(10.18.207.142 OKI-C9650-AB544B-PS)
[ General | TCPAIF | Metware | EtherTalk | NetBEUI | SNMP

™ Use TCP/IP Protocol
(] Use DHCP/BOOTP
1P Address [ro:18.207.142 |
Subnet Mask [255.255.255.0 |
Default Gateway [to18:207.1 |
[_]Use IPv6 Function
( Initialize ) ( Cancel y ) G—A-pplv—)

Menu Options

Discover Printers

Locates and lists all printers in your network which have an Oki
compatible network interface installed.

Printer status monitor

Displays the current status of the printer.

Printer NIC card summary
Displays the network interface summary details.

Change settings

Use this to configure the network interface settings (requires
Admin password).
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General Tab

OkiLAN 84509(10.18.207.142 OKI-C9650-AB544B-PS)
[ General | TCP/IP | Netware | EtherTalk | NetBEUI | SNMP

admin Password |“uu |

( Change... )

( Initialize ) ( Cancel ) f——*pplv—)

The General tab allows you to change the admin password.

1. Click Change.

2. Enter the current value, then enter the new value and re-
enter it under Confirm ....

NOTE

The default admin password is the last six digits
of the MAC Address, minus any punctuation

marks. e.g., for a MAC (Ethernet) Address of
00:80:87:A4:55:79, the password would be
A45579.

3. Click OK.
4. Click Apply.
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TCP/IP Tab

OkiLAN 84509(10.18.207.142 OKI-C9650-AB544B-PS)
[ General | TCP/IP | Metware | EtherTalk | NetBEUI | SNHP

¥ Use TCP/IP Protocol
(] Use DHCP/BOOTP
IP Address [ro-18:207.142 |
Subnet Mask [255.255.255.0 |
Default Gateway [1018.207.1 |
[T Use IPv6 Function
Initialize )] € Cancel ] G—WH
Item Comments
Use TCP/IP Enable/disable TCP/IP protocol.

Protocol

Use DHCP/BOOTP Click to select this item if the IP
address, subnet mask, default gateway
and IP addresses for DNS primary
server and secondary servers are
retrieved from the DHCP or BOOTP
server.

IP Address Set the IP address of the selected
network interface.

Subnet Mask Set the subnet mask of the selected
network interface.

Default Gateway Set the default gateway of the selected
network interface.

Use IPv6 Function Use to enable/disable IPv6.
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Netware Tab

Item

Comments

Use NetWare
Protocol

Enable/disable NetWare protocol.

Print Server Name

Set a Print Server name.

Frame Type

Set the primary NetWare frame type.

Operation Mode

Select the NetWare mode:
PSERVER Mode (the default)
RPRINTER Mode

Bindery Setup

Configure Bindery mode items,
including:

File Server to be | Specify up to 8

connected. file servers to
connect.
Password. Set a password

for the Print
Server.

Job Polling Time | Set the print job
polling interval in

seconds.

NDS Setup

Set the NDS Tree and Context where
the Print Server was created.

Printer Name

Set the NetWare printer object
name.
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EtherTalk Tab

OkiLAN 8450g(10.18.207.142 OKI-C9650-AB5448-PS).

[ General [ TCP/IP | Hetware | EtherTalk [ NefBEGI [TSHME

WiUse EtherTalk Protocol

Printer Name H ‘

Zone Name |‘ ‘

Initialize ) Cancel V] ( Apply )

Item

Comments

Use EtherTalk
Protocol

Enable/disable EtherTalk protocol.

Printer Name

Set the EtherTalk Printer object name.

Zone Name

Set the name of the zone to which the print
server belongs.
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NetBEUI Tab

OkilLAN £4509(10.18.207.142 OKI-C9650-AB5448-PS)

[

neral | TCRAIP | HetWars | Efhertalk | MetBEWI |ZSNEIE

™

Use NetBEUI Protocol

Short Printer Name ‘ ‘

Workgroup ‘F‘HHISENEY ‘

Comment [EthernetBoard OkiLAN 8450g |

{ Cancel ) € Apply )

Item

Comments

Use NetBEUI
Protocol

Enable/disable NetBEUI protocol.

Short Printer
Name

Set a name for the print server.

Workgroup Set a name for the work group to which
the print server belongs.
Comment Set the comments for the print server.
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SNMP Tab

OKILAN 84509(10.18.207.142 OKI-C9650-AB5448-PS)
General I TCRAR I HetWare I'EmEr.TaLk'I NetBEU] I SNMP

MIB-I| Parameters
SysContact ‘
SysName ‘ OKI=
SysLocation ‘
Initialize | ( Cancel ) @ “Apply )
Item Comments

SysContact | Set the printer manager name.

SysName Set the printer model name.

SyslLocatio | Set the location where the printer is installed.
n

Open web browser
Displays the printer web page.

Change utility preferences

Use this to configure the utility preferences for broadcast
addresses for TCP/IP protocol and Time Out.
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Utility Preferences TCP/IP Tab

Environment Setup

TCP/F | Timeout |

Set Broadcast Address

Add

Delete

Cancel ) ( 0OK )

Item Comments

Set Broadcast Set broadcast addresses that are used to
Address search Oki network interfaces using the
TCP/IP protocol.

Add Click Add to add the address to the list in
the box.
Delete Select an address in the box, then click

Delete to remove it.
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Utility Preferences Timeout Tab

Environment Setup

TCPAR I Timeout

[Set Timeout

Printer search setting

Polling Interval (20-180 seconds)

Data Send/Receive

Time Outs (1-60 seconds}
Retrys (1-5)
Cancel ) ( oK )
Item Comments
Set Timeout: [Search Every (20-180sec)]
Printer Search Set the response waiting time from the
network interface in seconds. Default is
30 seconds.
Set Timeout: [Time Outs (1-60sec)]
Data Send/ Set time out between AdminManager and
Receive the network interface in seconds. Default
is 5 seconds.
[Retry (1-5)]
Sets how many times AdminManager will
retry to transmit/receive data to/from the
network interface. Default is 3 retries.
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Connecting to Your Printer

Tiger (10.4)
Bonjour, AppleTalk or USB

1.

N

Launch Printer Setup Utility
This is located in the Applications > Utilities folder.

. Click Add....
. Select your printer model from the Default Browser.
8o Printer Browser =
= L
. Click Add.
Depending on the connection type, you may be prompted
to configure any additional printer hardware options. If
your printer has options such as a hard disk or second
tray, switch on the relevant options.
. Quit Printer Setup Utility.
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TCP/IP Connection

1.

W

8.
9.

Launch Printer Setup Utility
This is located in the Applications > Utilities folder.

. Click Add....
. Click the IP Printer button.
. From the Protocol menu, choose Line Printer Daemon

- LPD.

. Enter the printer’s IP address in Address.

806 Printer Browser (=)
=0 L

Default Browser | IP Printer Search

Protocol: | Line Printer Daemon - LPD |

Address B3

Enter host name or IP address

Queue: vl

Leave blank for default queue

Name:
Location:

Print Using: )

is More Printers

. Check the correct PPD file for your printer is selected in

the Print Using menu.

Click Add....

You will be prompted to configure any additional printer
hardware options. If your printer has options such as a
hard disk or second tray, switch on the relevant options.
Click Continue.

Quit Printer Setup Utility.
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Panther (10.3) and Jaguar (10.2)

Rendezvous

NOTE

This utility is called Print Center on Mac OS X
10.2.x.

If your printer is already listed, your Mac may
already have discovered the printer before you

installed the Oki software. In this case, the
printer may be using the incorrect PPD file or
may not have the correct hardware options
configured. You should delete the printer, quit
Printer Setup Utility, and re-launch the utility
before continuing.

If you have not already done so, run the Oki software installer
before following the steps below.
1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

Click Add....

From the pop-up menu, choose Rendezvous.
Select the printer you wish to connect to.
Click Add.

Click the Printer Setup Utility menu, and choose Quit
Printer Setup Utility.

After adding the printer, you should configure printer hardware
options. Refer to “Configuring Printer Hardware Options” on
page 81.

aunhswnN
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IP Connection

If you have not already done so, run the Oki software installer
before following the steps below.

1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

NOTES

This utility is called Print Center on Mac OS X
10.2.x.

If your printer is already listed, your Mac may
already have discovered the printer before you

installed the Oki software. In this case, the
printer may be using the incorrect PPD file or
may not have the correct hardware options
configured. You should delete the printer, quit
Printer Setup Utility, and re-launch the utility
before continuing.

Click Add....

Click the pop-up menu and choose IP Printing.

Click the Printer Type menu and choose LPD/LPR.

Enter the printer's IP address.

To find the printer’s IP address, you can print a

configuration page from the printer’s operator panel (see

page 9).

6. Enter the queue name. If you do not know the queue
name, leave it as Use Default Queue on Server.

7. Click the pop-up menu and choose your printer model.

8. Click Add.

9. Click the Printer Setup Utility menu, and choose Quit

Printer Setup Utility.

After adding the printer, you should configure printer hardware
options. Refer to page 81.

uihwn

AppleTalk connection

If you have not already done so, run the Oki software installer
before following the steps below.
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1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

NOTE
This utility is called Print Center on Mac OS X

10.2.x.

Click Add....

From the pop-up menu, choose AppleTalk.
Select the printer you wish to connect to.
Click Add.

Click the Printer Setup Utility menu, and choose Quit
Printer Setup Utility.

aunhswnN

USB connection
If you have not already done so, run the Oki software installer
before following the steps below.
1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

NOTE
This utility is called Print Center on Mac OS X
10.2.x.

If your printer is already listed, your Mac may
already have discovered the printer before you

installed the Oki software. In this case, the
printer may be using the incorrect PPD file or
may not have the correct hardware options
configured. You should delete the printer, quit
Printer Setup Utility, and re-launch the utility
before continuing.

Click Add Printer....

From the pop-up menu, choose USB.
Choose a printer to connect to.

Click Add.

PUNRH
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5. Click the Printer Setup Utility menu, and choose Quit
Printer Setup Utility.

Configuring Printer Hardware Options ___

NOTE
Applies to IP and Rendezvous network

connections only.

If you have added additional hardware, for example additional
paper trays, to your printer these must be enabled in the
printer driver.
1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

NOTE
This utility is called Print Center on Mac OS X
10.2.x.

Ensure that your printer model is selected.
Click the Printers menu, and choose Show Info.
From the popup menu, select Installable Options.

Select any options appropriate to your hardware, and
click Apply Changes.

uhwbn

NOTE

Not all utilities, features or protocols are
supported by every product. See the front cover

of this manual for a listing of the items
supported by your product.
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Network Printing using UNIX

NOTE
This section does not apply to GDI printers.

Not all utilities, features or protocols are

supported by every product. See the front cover
of this manual for a listing of the items
supported by your product.

Overview

Printers support many protocols such as LPD, FTP, TELNET,
SNMP and IPP, and work within the UNIX environment.

To use the printer within the UNIX environment, the following
steps are required:

Configuration

Network Interface Setting

The first step in installing the printer under UNIX is to set up
the IP address, Subnet Mask and Gateway. This section
explains one way to set them up from a UNIX workstation.

The network addresses used in this manual are shown as
examples only. Network addresses used in your installation
must be generated for your own network.

Log in as root to change the configuration of the printer.

If an incorrect IP address, Subnet Mask or Gateway is
entered, the network may go down or other damage may
occur. Check the address with your network manager.

The following explanation uses Sun Solaris 2.8 (Solaris 8) as
an example. The actual commands may differ between
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versions of UNIX, so refer to the workstation manuals for more
information.

NOTE
If you do not have superuser rights, the network

manger should conduct the configuration.

1. Log in as root to the workstation.

2. If the printer does not have an IP address already
assigned, use the arp command to set a temporary IP
address.

Example: for IP address 192.68.20.127 and network
interface address 00:80:87:01:00:D2

# arp -s 192.168.20.127 00:80:87:01:00:D2 temp

The Ethernet address (MAC address)
00:80:87:01:00:D2 in the above example can be
determined from the Network Configuration report (see
page 9).
3. Use the ping command to confirm the connection with
the network interface.

Example: for IP address 192.168.20.127
# ping 192.168.20.127

If there is no reply, there is a problem with the
configuration of the IP address (the IP address has
already been set manually or dynamically), or with the
network. Reset the network interface settings to default
and try to set a temporary IP address.

If you still have the problem after resetting the network
interface, consult the network manager.
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4. Login to the network interface using TELNET.
Example: Logging in to IP address 192.168.20.127

#telnet 192.168.20.127

Trying 192.168.20.127

Connected to 192.168.20.127
Escape character is ‘*'.
EthernetBoard 8100e TELNET server
login: root

‘root’ user needs password to login.
password: <CR>

User ‘root’ logged in.

No. Message Value (level .1)

1 : Setup TCP/ IP

N

Setup SNMP

3 : Setup NetWare
Setup EtherTalk
Setup NetBEUI

Setup printer trap

< o Ul

Setup SMTP (Email)

9 : Maintenance

10 : Setup printer port
11 : Display status

12 : IP Filtering Setup
97 : Network Reset

98 : Set default (Network)
99 : Exit setup

Please select (1- 99)7?
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5. Type 1 and press the Enter key. Perform the following
settings:

Please select (1- 99)? 1

No. Message Value

1 TCP/ IP protocol : ENABLE

2 IP address : 192.168.20.127

3 Subnet Mask : 255.255.255.0

4 Gateway address : 192.168.20.1
5 RARP protocol : DISABLE

6 : DHCP/ BOOTP protocol: DISABLE

7 : Auto IP Address : DISABLE

8 : DNS Server (Pri.) : 0.0.0.0
9 : DNS Server (Sec.) : 0.0.0.0
10 : root password : “WkkFEkxkkn

11 : Auto Discovery Setup
99 : Back to prior menu

Please select (1- 99)?

6. Logout from the network interface. Turn the printer off
for about 15 seconds and on again to validate the
settings.

LPD Printing

Line Printer Daemon (LPD) is the most common protocol for
printing with TCP/IP to a network printer. Refer to the
workstation’s manual for details of Ipr and Ip commands. The
following explanation in this section uses the printing of print
file test.prn with printer name Myprinter_Ip as an example.

Logical printers
The printer’s network interface includes three logical printers.

e |p must be used for printing a file created using the printer
driver.
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e sjis must be used for printing a text file of Shift JIS Kanji
code.

® euc must be used for the printing a text file of the EUC
Kanji code.

Logical printer Printer function

Ip For direct output

sjis For Shift JIS Kanji converted output
euc For EUC Kanji converted output

7. sjis and euc function only as PostScript printers.
BSD-based UNIX
Print using the Ipr command.
# lpr Pmyprn lp test.prn
If the Iprm command is used, the print job is cancelled.

Example: To delete a print job (Job ID 123) on the
myprn_Ip

# lprm Pmyprn lp 123
Verify the printer status using the /pg command.

e The result of Ipq may not be displayed correctly depending
on UNIX operating system specification.

e While the short format of /pg is a UNIX compatible format,
the long format is unique to this network interface.

Example of the short format: # Ipq Pmyprn_Ip
Example of the long format: # 1lpg Pmyprn lp lp
System V-based UNIX
Print using the Ip command.
# 1p -d myprn lp lp test.prn
Delete a print job using cancel command.

Example: To delete a print job (Job ID 456) in the
myprn_Ip

# cancel myprn 1lp -456
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Verify the printer status using the Ipstat command.
# lpstat myprn 1p

The result of Ipstat may not be displayed correctly depending
on UNIX operating system specification (e.g. Solaris 2.x).

FTP printing

FTP (File Transfer Protocol) is used for transferring a file with
TCP/IP. If the print data is sent to a logical printer via FTP, it
is printed.

Refer to the workstation’s manual for details of the ftp

command. The following explanation uses print file test.prn
with printer name myprn_Ilp as an example.

Logical directories

The printer’s network interface includes three logical
directories.

e Ip must be used for printing a file created using the printer
driver.

e sjis must be used for printing a text file of Shift JIS Kanji
code.
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e euc must be used for the printing a text file of the EUC
Kanji code

Logical directory Printer function

Ip For direct output

sjis For Shift JIS Kanji converted
output

euc For EUC Kanji converted
output

e jis and euc function only as PostScript printers.
® You can not send data to the root directory.

1. Log in to the network interface.
When printing with ftp, use any values for name and
password. However, if the user name is root, the
password set under TELNET or the utility is required. See
the appropriate section for details.

Example: Logging in with host name myprn (or IP
address 192.168.20.127).

# ftp myprn (or ftp 192.168.20.127)
Connected to myprn

220 EthernetBoard 8100e Ver 01.50 FTP Server
Name (myprn:<nones>) : root

331 Password required.

Password:<CR>

230 User Logged in

ftp>

The network interface logical directory structure is
hierarchical. Move to the logical directory; it is not
possible to output print data to the root directory.
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2. Move to the preferable logical directory using the cd
command.

Example: moving to the Ip directory and confirming the
current directory.

ftp> cd /lp

250 Command OK.

ftp> pwd

257 " /1p"” is current directory
ftp>

3. Configure the transfer mode.

There are two types of transfer mode: BINARY mode, in
which the file content is output as it is and ASCII mode,
which converts the LF code to the CR+LF code. If a binary
file converted by the printer driver is transferred, the
transfer mode has to be BINARY mode.

Example: Changing transfer mode to binary mode and
verifying the current mode:

ftp> type binary
200 Type set to I.

ftp> type
Using binary mode to transfer files.
ftp>

4. Transfer the print data to the network interface using the
put command. Two methods of file transfer using the put
command are available.

Example: Transferring print data test.prn
ftp> put test.prn

Example: Transferring print data specified by absolute
path/users/test/test.prn

ftp> put /users/test/test.prn /lp
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5. Logout from the network interface using the quit
command.

ftp> quit

Three states can be verified using the quote command
stat: the IP address, login user name and transfer mode.
In addition, printer status can be verified by specifying the
directory after the stat (lp, sjis, euc).

Example: Displaying the network interface status

ftp> quote stat

211-FTP server status:

Connected to: 192.168.20.10.000.00
User logged in: root

Transfer type: BINARY

Data connection: Closed.

211 End of status.

ftp>

Example: Displaying the network interface status
(directory name: Ip)

ftp> quote stat /lp
211-FTP directory status:
Ready

211 End of status

ftp>
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Troubleshooting

The network addresses used in this manual are shown for
example only. Network addresses used in your installation
must be generated from your own network.

Self-diagnostic Test

Printer does not print.
Ensure the printer emulation is set to PS or Automatic.

NG is printed in the self-diagnostic test or Flash
ROM Check Registers NG.

Turn the printer off for 15 seconds and then on again.

Press the reset button on the rear panel, next to the network
interface port, to re-initialize the printer.

TCP/IP

Computer cannot find the network interface.

Turn the printer off for 15 seconds and then on again.
Confirm the network interface is enabled on the printer.
Check there is a response to the PING command.

Check that the network cable is correctly connected and
that the green LED close to the printer’s network interface
is lit. If not, change the cable and try again.

Open Admin Manager (Start > Programs > Oki Setup Utility
> Admin Manager, or run it from the CD supplied with your
unit) and run the Self-diagnostic test (Setup > Test Print).

Check that the IP Address, Subnet Mask and Gateway are
correct.

Check that the TCP/IP protocol is set to Enable.
Reset the network interface to the factory default settings.

If DHCP, BOOTP and RARP are not used, ensure they have
been set to Disable.
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Cannot print with Ipr and ftp.

Turn the printer off for 15 seconds and then on again.
Check there is a response to the ping command.
Check the network cable is correctly connected.
Change the cable and try again.

Check the host name and IP address are configured in the
workstation.

Check the printer port name is configured in the
workstation.

There are three port names: Ip, euc and sjis. Use Ip by
default as euc and sjis are specific to PostScript printers.

Incorrect user name on the banner page.

If printing with Ipr, the user name printed is unknown and
the filename printed is the Spool file name.

If printing with FTP, the user name printed is the user name
entered during FTP login and the file hame printed is the
transmitted file name. If the print directory name is
indicated in the put command, the file name is not printed.
The printer name printed is the logical directory name.

NetBEUI

The network interface is not identified.

Turn the printer off for 15 seconds and then on again.
Check the network cable is correctly connected.
Change the cable and try again.

Check that Microsoft Network Client and NetBEUI have
been added to the network section of the Windows Control
Panel.

Check that the NetBEUI protocol is set to Enable.

Check that the factory setting of the workgroup name is
PrintServer and the computer name is ML+ the last six
characters of the MAC address.
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o Check if the computer name of the NIC is different from the
computer name on the network.

Error writing to Prnl.
® Check if the printer is online.

e If there is an error message indicating the paper has run
out, add more paper and cancel the error.

® Check whether another user is printing. Print after the
other user has finished.

Mac

Blank pages or garbled text printed.
Symptoms:
When printing via a USB or TCP/IP connection, you receive
blank pages or pages printed with a line of garbled text.
Cause:

This issue is normally caused by the data being sent to the
printer in binary format. The printer may not be able to
understand data in this format, and therefore may print blank
pages or garbled text.

Solution:

In your application’s print options, there may be an option to
send data as ASCII. Choose this option, and print your
document.

For example, in Adobe Photoshop 7 or Adobe Photoshop CS:
1. Click the File menu and select Print with Preview.
2. Click the box Show More Options.
3. From the pop-up menu, choose Output.
4. From the pop-up menu Encoding, choose ASCII.

Banner print is rotated by 90 degrees and is
printed at the bottom of the paper.

Mac OS X 10.2.3 or greater
Possible causes and solutions:
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e Not enough RAM in the printer to process the print job.
- Try printing at a lower resolution.
e Incorrect custom paper size being specified.

- Ensure that the Custom Paper Size in both the printer
driver and your application are exactly the same.

NOTE
Ensure that the custom paper size is correct in
the printer driver (e.g. 320 x 900mm).

If the custom paper size is wrong (e.g. 328 x
900mm), the OS X PostScript driver will replace
this with the default paper size - normally letter.

Mac 0S 10.2.3 - 10.2.8 only
e The print job may have been rotated by your application.

An anomaly in the core Mac OS X 10.2.x causes custom
paper sizes to be incorrectly rotated by 90 degrees, the
Oki PostScript Printer Description (PPD) file implements a
counter-rotation to solve this problem. However, some
applications such as Quark Xpress or Macromedia
Freehand may create their own PostScript code. For these
applications, the custom paper size rotation issue does
not apply.

In such cases, if the Oki PPD file is selected in Quark or

Freehand’s print dialog, the print job will be incorrectly
rotated by 90 degrees.

The Oki printer driver contains a Page Rotate option - this
may be used to fix the problem. Alternatively, you may be
able to rotate the page in your application program.

No printing or print queue stopped.
Symptoms:

Upon sending a job to the printer, the job disappears
completely and is not printed, or the job remains stalled in the
Printer Setup Utility (Print Center).
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Cause:

The Oki printer PostScript Printer Description (PPD) file has a
dependency on a filter file. This filter file must be installed the
following location:

Jusr/libexec/cups/filter/OkfilterA

If this file is deleted, or is not present on your computer, jobs
will not be sent to the printer at all. This can happen if you
deleted this filter file, or if you copied a PPD file from another
Mac and did not use the Oki Software installer.

Solution:

Run the Oki printer software installer contained on the CDs
that were supplied with your printer. This will install the CUPS
filter file and allow normal printing.
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